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Introduction

The volume of the hippocampus is a commonly used structural MRl measurement in brain research. Many studies focus on a decrease
in hippocampal volume associated with a wide variety of neurological and psychiatric conditions including depression', posttraumatic
stress disorder (PTSD)??, borderline personality disorder (BPD)*, schizophrenia®#, alcohol abuse’ and Alzheimer’s?, Parkinson’s and

Huntington'’s diseases’.

It is as yet unclear what mechanisms underlie the decrease in hippocampal volume associated with major depressive disorder (MDD)’.
Cross-sectional studies are incapable of determining definitively whether decreased hippocampal volume is caused by MDD or is a
contributing factor to MDD, so it is recommended that longitudinal studies be conducted to determine the causal relationship between
MDD and hippocampal volume™. Decreased hippocampal volume in MDD patients may lead to recollection memory impairment. It may
also be related to an increase in glucocorticoids caused by stressful events and exacerbated by decreased inhibition of the hypothalamic-
pituitary-adrenal (HPA) axis as a result of decreased hippocampal volume'". It has been found that antidepressants used during episodes
of depression may protect the hippocampus from decreasing in size'? and that there is an association between duration of depression and

reduced hippocampal volume' ™.

Decreased hippocampal volume has been identified in Vietnam veterans with PTSD, and hippocampal volume was directly correlated
with combat exposure. This correlation may be explained by combat stress causing PTSD, which in turn damages the hippocampus, or by
an increased likelihood of individuals with smaller hippocampi either being assigned to combat units or developing PTSD when exposed
to combat stress?. Decreased hippocampal volume has not been found to be a necessary risk factor for developing PTSD and does not
occur within six months of the onset of PTSD. The lower hippocampal volume observed in some PTSD patients may be related to chronic
or complicated PTSD or related distress. The frontal lobe may be the area of the brain most significantly affected by PTSD, rather than the
hippocampus®. In adults who sustained childhood trauma in the form of abuse or maltreatment, hippocampal volume is reduced™. This
effect is not observed until adulthood, suggesting there is a delay between the childhood causal factors and the reduced hippocampal

volume effect's".
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Hippocampal volume is frequently used in the study of Alzheimer’s disease (AD) and as such may be developed into a standardized
biomarker for dementia and AD'®". The volume of the hippocampus, adjusted for age and gender, has been found to best discriminate
controls from early-onset AD cases in comparison to other medial temporal lobe structures?’. However, a stronger correlation was found
between change in hemispheric volume measurements (whole brain and ventricle) and cognitive performance compared to the correlation
between medial temporal lobe volume decrease and cognitive performance?'. MRI-based hippocampal volume measurement may become
a useful diagnostic tool in cases of memory impairment which may indicate early-onset AD®, and measurement of whole brain atrophy rates

may be preferable for some clinical trials, especially considering that it can more easily be automated?'.

Findings from the Nun Study have shown that hippocampal volume as measured by postmortem MRI was able to identify differences
between Braak stages of AD pathology as determined by histopathology. This suggests that hippocampal volume could be used to identify
AD at early stages in patients long before they show clinical symptoms. This should be considered along with findings that 43-67% of
individuals fulfill neuropathologic criteria for diagnosis of AD at autopsy yet never exhibited dementia??. Measurements of hippocampal
volume from MRI have been used to show that patients with mild cognitive impairment (MCl) who have smaller hippocampal volume are

more likely to convert to AD than MCI patients with larger hippocampi?.

In order to be widely used as a biomarker in clinical practice and clinical trials, hippocampal segmentation will have to be automated, but
the gold standard of hippocampal segmentation remains manual tracing'®. The bottom line is that structural volume measurements as
determined by MRI provide a more reliable assessment of AD progression than cognitive tests alone. Imaging should be used in conjunction

with standard cognitive tests in AD therapeutic trials?'.

©2015 AnalyzeDirect, Inc.
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The population in the developed world is increasingly aging, and researchers are trying to confirm ways of preventing or reversing cognitive
atrophy. One group found that higher fitness levels were associated with increased left and right hippocampal volume in nondemented
adults, which was also associated with increased performance on spatial memory tests?. Spatial navigation training maintained hippocampal

volume in both younger and older men, while controls experienced a decline in hippocampal volume over time?>.

Insulin resistance is a cause of cardiovascular disease, diabetes, and obesity, which are in turn risk factors for dementia and AD?. Insulin
receptors in the central nervous system are mostly located in or near the hippocampus, and a negative correlation has been demonstrated

between insulin resistance and hippocampal volume?’.

Note that the sample data set shown is a 1.5 Tesla T1-weighted MR image. Because of the relatively low field strength, the boundaries of the
hippocampus are not always clear due to partial volume effects. Data acquired at a higher field strength such as 3T or even 7T would have
a higher resolution and signal-to-noise ratio, and an atlas of the hippocampus has even been created from 9.4T postmortem scans?. Partial

volume effects can also be reduced by acquiring the data orthogonal to the long axis of the hippocampus.

Using a higher field strength would also allow for the segmentation of the hippocampus into its subregions. In particular, reduced
hippocampal tail volume has been observed in patients with MDD and schizophrenia?”3. This guide focuses on the steps necessary to

segment hippocampi and measure total hippocampal volume in AnalyzePro.

©2015 AnalyzeDirect, Inc.
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Loading Data

* Open Input/Output.

Download the MRI_3D_Head
data set to follow along

* NaVIgate to and select the http://analyzedirect.com/data/

MRI_3D_Head data set.
¢ Click Load Volume.

¢ Once the data is loaded into

AnalyzePro, close Input/Output.

7Y

Input/Output

Input Type: @ Disk () Workspace

") Database () Pacs

v CvENr Sample Data » TutorialData »

[ AdditionalData
DColormaps
DImageF’rocessingTutorial
[:IlmportExportTutorial
[CAMultiSpectralTutorial
[AvolumeToolTutorial

D AdjacentSections.avw
D.AdjacentSlabs.a\M

D BeatVol.avw

D Binary_CT_Brain.avw
D Canine_Chest_CT.aw
D Coronary_CT.avw

[ cT_Heart.aw

[ cT_Liver.aw

[ cT_Lungs.aw

[} cubic_CT_Head.aw

a4 I

| Cubic_CT_Head.obj

D Cubic_CT_Head.smp

[ Edited_MRI_Head.aw
[ Edited_PET_Head.avw
[ EGV_MRILavw

D Electrodes_FabTool.log.td
D FatCells.avw

D Heart_Time_Puoint_1.avw
D Heart_Time_Puoint_2.avw
[ MRI_3D_Brain.avw

[ MRI_3D_Brain.obj

[ MRI_3D_Brain_Bin.avw
[ MRI_3D_Head.aw

[ MRI_3D_Head.obj

[} MRI_3D_Head0.abj

[ MRI_Head.avw

Load Volume [ Info

Anterior

Posterior
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Preprocessing Steps

There are a number of data preprocessing steps that will aid in manual hippocampus segmentation. It is recommended to reslice the data
orthogonal to the AC-PC line for consistency. In addition, upsampling the data through interpolation to create a smaller voxel size will allow
you to define hippocampal regions more precisely. Finally, cropping or subregioning the data to zoom in on the region containing the

hippocampus will reduce the size of the data set and speed up processing and rendering times, especially on slower systems.

©2015 AnalyzeDirect, Inc.
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Manual AC-PC Alignment of Brain Data

Spatial Intensity  |Image Image |Image
Transforms |Transforms | Calculator | Algebra | Repair

F. A R\ -+
4 |

Pad Subregion  Resize  Shift Flip

According to the current standards .
set by EADC (European Alzheimer’s -

€Y,
Disease Consortium) and ADNI x n

(Alzheimer’s Disease Neuroimaging

Initiative)3'32, the structural MRI brain

) Transform
data should be AC-PC aligned before 10 00 00 0.0
segmentation. The brain data can 0.0 10 0.0 0.0
be aligned along the AC-PC axis as 0.0 00 10 0.0
described in the following section. 4 00 00 10
[ View Transposed
¢ Select the data set to align Manipulate Matrix

along the AC-PC axis and open Rotate ~ X v degree(s) O Apply
Transform.

e Select the App|y Matrix tool. Transformed Volurme Size: () Maintained @ Best Fit

* Navigate to Spatial Transforms.

Interpolation Type: () Mearest Neighbor
() Linear
@ Cubic Spline
71 Windowed Sinc

Transform Min: (1 DataType (0)
@ Data Minimim (1)
() User Specified, 1

Apply Matrix
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The optimal screen layout for AC-PC

alignment can be set as follows: e

e Switch off the rendering using

the Toggles Rendering button.

* Now the three orthogonal views

are shown.

Axial Slice = 94 M onal Slice = 119 Inferior

©2015 AnalyzeDirect, Inc.
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* Switch on the oblique.

A ] £

* Now the oblique and the three

orthogonal views are shown.

Superio

I Slice = 119 Inferior

©2015 AnalyzeDirect, Inc.
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* Toggle the orthogonal orientations ‘ _* s

to a single image using the

Toggles All Orients button.

C(5
0im
RiG

FIFH<D

e Set this image to the sagittal view
by clicking twice on the Orient
parameter at the bottom left of
the image.

* Now the sagittal orientation and

the oblique image are shown.

©2015 AnalyzeDirect, Inc.
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NOTES

* Switch on the perpendicular

HEEEA

images using the Toggles

Perpendicular button.

These are the planes perpendicular
to the oblique plane as it is defined
at any moment and can be used to
verify the choice of oblique plane.

Now the sagittal orientation, the _
oblique image and the two planes - | ¥ i s
perpendicular to the oblique image |

are shown.

©2015 AnalyzeDirect, Inc.
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e The AC-PC line will be defined

on the sagittal view, so double-

NOTES
EHOH]

EEEa =

click the sagittal image or que a5 rimary

Mo Primary Image

select Image as Primary in the

dropdown menu.

©2015 AnalyzeDirect, Inc.
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e Right-click on the sagittal image
and select Perpendicular Axis
to turn on the perpendicular

axis tool.

¢ Navigate to the mid-sagittal
slice, which for this data set is
slice 90.

* Drag the left endpoint of
the perpendicular axis to the
posterior commissure.

* Drag the right endpoint of
the perpendicular axis to the

anterior commissure.

Middle Button Action  *
Mouse Wheel Action P

Copy te Clipboard

Three Points
v Cursor Link

v Axis Labels
Border Ruler
Reset

©2015 AnalyzeDirect, Inc.
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* To set the oblique plane to be
parallel, rather than perpendicular,
to the AC-PC plane, right-click
on one of the perpendicular axis

endpoints and set the Matrix to

; : E Perpendicular @ Start Point (This Point)
Create to Pa ra”el. o ; v Set Slice v Perpendicular @ Center Point

v Perpendicular Axis Perpendicular @ End Point

©2015 AnalyzeDirect, Inc.
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* Now the main oblique image (the
leftmost of the three) is an AC-PC
aligned axial image.

e Double-click this image to make

it the primary image.

Inférior

©2015 AnalyzeDirect, Inc.
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® The AC and PC can both be
seen on the same oblique
slice, indicating good AC-PC
alignment.

® To adjust vertical alignment of the
data set, right-click Yaw and set

the Rotation Increment to 1.

Pitch

Translation Increment ¥ L)
Interpolation v
5
Configure
&7

15

2

©2015 AnalyzeDirect, Inc.
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* Use the left and right Yaw
buttons to align the data set
vertically. The increment can
be made even smaller to make

smaller adjustments as needed.

Pitch

©2015 AnalyzeDirect, Inc.
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® The last adjustment to be made
to the oblique plane will be
done using the Roll function.

e Right-click on Roll and change

the Rotation Increment to 1.

Rotatio

Translation Increment *

Interpolation 3

Configure

©2015 AnalyzeDirect, Inc.
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* Click on the left and right roll
buttons to adjust the data set
until the anatomical structures

appear symmetrical.

©2015 AnalyzeDirect, Inc.
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* Click the Apply Matrix button to

apply the transformation.

m H :E
[ F

Pad Subregion  Resize  Shift Flip

#

Follow
Path

0999238 0020560 -003315  0.106856
-0.01745  0.985657 0091437 19.57691
0.034894  -0.09078 0995258 -21.9265

0.0 0.0 0.0 1.0

[C] View Transposed
Manipulate Matrix

Rotate - £ v degree(s) O Apply

Transformed Veolume Size: ) Maintained @ Best Fit

Interpolation Type: (7 Mearest Neighbor
() Linear
@ Cubic Spline
() Windowed Sinc

Transform Min: ) DataType (0]
@ Data Minimim (1)
(7 User Specified | 1

]
3

©2015 AnalyzeDirect, Inc.
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¢ Click Save Volume button at the RGeS

File Other Help

bottom of left of the window to o e
1 m il
save the transformed data set. Pi v R S Fi
10 00 0.0 00
0.0 10 0.0 00
0.0 00 1.0 00
0.0 00 0.0 10

View Transposed
Manipulate Matrix

Rotate v X ~ degreels) 0 [ 4poy |

Reset Marx | [ Load Matrix [ save Matrix

Transformed Volume Size: Maintained @ Best Fit
Interpolation Type: () Nearest Neighbor
Linear
© Cubic Spline
Windowed Sinc

Transform Min: ©) DataType (0)
® Data Minimim (1)
User Specified| 1

{Apply Matrid

Save Vo s Redo | |Undo
=—— [ Copyright 2010-2015, BIR, Mayo Clinic
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¢ |n the Save Transformed

window, choose to create a new N
() Replace contents of '"MRI_3D_Head'.

workspace volume.

(@ Create a new workspace volume.

® Rename the file and click Save

Workspace Main -
Volume.

File MRI_3D_Head_ACPC

SaveNolume
[soveolume|

¢ Close Transform.

©2015 AnalyzeDirect, Inc.
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Cropping and Upsampling for Improved Segmentation

The hippocampus is a relatively small structure compared to the whole brain. For this reason, unless the data was taken at an extremely
high resolution, the definition of the hippocampal region in the original data set will likely not be completely smooth due to large voxel size
compared to the size of the hippocampus. To be able to more precisely define the hippocampus, the data can be upsampled (interpolated)

to create a smaller voxel size.

However, upsampling the entire data set may result in too large a file size. To reduce the size of the data set, it can be cropped
(subregioned). The cropping and upsampling steps are optional and can also be performed individually, depending on which are necessary
for the data.

©2015 AnalyzeDirect, Inc.
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¢ Select the AC-PC aligned data

and open Transform.
* Under the Spatial Transforms tab, X n

select the Subregion tool.

¢ Click and drag the yellow

Transform
control points around the
. . 1| MRI_3D_Head_ACRC
image in all three orthogonal oy
. . oo T e et ;
orientations to crop around the A . L
4 - fw o oem
part of the brain containing the ) s e g
low Inc High Num Max
hippocampus. T
z 74 1 126 53 Ao
e Click Extract Sub Volume to "/ T O Y
Auto Crop
complete the crop. T
o M Inferior Inferior
Save Volume... Redo Undo =

©2015 AnalyzeDirect, Inc.
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* To upsample the data, navigate

File Other Help
to the Resize tool. Tt s o R o] = =
. | ﬁ ‘W Ol Gl ﬁ,/ Anterior
e Check the Force Cubic checkbox # . st By o
and change the voxel size to a o e
Dim. Size Size Dim.
x[ s 1 203
smaller value. i— : 5w
Z 53 1 17
Memory| _ 0.41|Mb 1518 Mb
¢ Use the drop-down menu to
Interpolation Cubic Spline =
select an interpolation type.
Cubic Spline and Windowed Sinc
are recommended as the most
likely to preserve the data as it
is interpolated.
¢ Click Resize Volume to complete
the interpolation.
P Redo] [unde) A ‘ v = S| Inferior 3/ Min = 255/1 | 5ag Inferior

©2015 AnalyzeDirect, Inc.
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¢ Click the Save Volume button in

the bottom left of the window.

e In the Save Transformed () Replace contents of ‘MRI_30_Head ACPC'.

window, choose to create a new @ Create a new workspace volume.
workspace volume.

Waorkspace Main -
* Choose a workspace from the

File MRI_30_Head_ACPC_Cro p_IntI

drop-down menu.
* Rename the file.

¢ Click Save Volume to save the

transformed volume.

¢ Close Transform.

©2015 AnalyzeDirect, Inc.
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Manual Segmentation of the Hippocampus

The segmentation will be performed primarily in the coronal view, from rostral to caudal. The EADC-ADNI Harmonized Protocol for Manual

Hippocampal Segmentation (HarP) requires 3D navigation for frequently checking anatomical structures against the sagittal and transverse views

during the segmentation process. The linked cursor in Segment provides an optimal method for viewing structures in all orthogonal orientations.

©2015 AnalyzeDirect, Inc.


http://www.hippocampal-protocol.net/SOPs/LINK_PAGE/HarmonizedProtocol_ACPC_UserManual_biblio.pdf
http://www.hippocampal-protocol.net/SOPs/LINK_PAGE/HarmonizedProtocol_ACPC_UserManual_biblio.pdf

ANALYZEPRO HIPPOCAMPAL VOLUME ASSESSMENT GUIDE 27

* Open the AC-PC aligned,
optionally preprocessed T1 MRI
brain data set in Segment.

e Click the Add Object button in the

bottom left of the window twice

) Segment
to add two new objects.
* Name the objects Right_ [ IWoriginal |
. - : Mame Original M
Hippocampus and Left_ @.nght_HlppDcar
Hippocampus. W Left Hippocam ["] Display [] Locked
i Color White
Add Object ‘

©2015 AnalyzeDirect, Inc.
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The segmentation method will not be described in anatomical detail here, as that is beyond the scope of this document. Please refer to the

EADC-ADNI protocol for detailed instructions on manual hippocampus segmentation.

Note: AnalyzePro uses a left-handed coordinate system, so the sagittal images as seen in AnalyzePro are mirror images of the sagittal view as seen in
the EADC-ADNI Protocol.

Use the manual trace tool to delineate hippocampal tissue. To do this, select the object to be defined, Right_Hippocampus or Left_
Hippocampus, then click on the Manual Trace tool under the Manual tab, and trace around the hippocampus on the given coronal

slice. Mistakes can be fixed by clicking the Undo button and retracing the contour. The Nudge Edit tool can also be used to expand the
hippocampus contour (by clicking inside the hippocampus and dragging out along the inside of the contour) or to nudge the contour back
from the outside (by clicking in the Original object and dragging along the outside of the contour). The size of the Nudge Edit tool can be

adjusted by holding down the middle mouse button and moving the mouse up or down.

Move through the coronal slices, defining the Right_Hippocampus and Left_Hippocampus objects using the Trace tool and checking against
anatomical landmarks as described in the EADC-ADNI protocol. Save the object map periodically during the segmentation process (File >
Save Object Map).

©2015 AnalyzeDirect, Inc.
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A few representative coronal slices with the right and left hippocampal objects defined are shown below, from rostral to caudal.

©2015 AnalyzeDirect, Inc.
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A hippocampal sulcal cavity*-%
appears on one of these slices, the
segmentation of which can be more
clearly seen by toggling the display
using the Toggle Region Display

button.

To exclude a region from the sulcal cavity

hippocampal

hippocampus object, the Freehand
Draw tool (under the Manual tab) can
be used to assign such a cavity to the

Original object.

An example rendering of the
segmented hippocampi is shown

below.

Note: Hippocampal subregions such as
the tail can be manually segmented by
adding further objects and assigning
voxels to these objects using manual
tools as described for the whole

hippocampus above.

©2015 AnalyzeDirect, Inc.
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Measurement of Hippocampal Volume

As discussed in the introduction, the
volume of the hippocampus is the

measurement of interest.

|1
Zcm

* Select the data set and open

Measure. Load the object Measure
map saved at the end of the e
. . File Other Help
segmentation (File > Load e
[=D | 20 | 3D
Object M ap) bo  Sgecd | -
e Under the 3-D tab, select the —
ample Options
. “| Combine Enabled Objects MName|Combined
Enabled Objects tool.
Stats to View
e Select the Size Intensity S e e
Orient Number of Voxels [_] Histogram
tab and make sure Volume Tsee e
7 Maximum ] Mean
is checked. i o
[7] Min Location [ Entropy
¢ Check the Auto Log Stats
checkbox below the Stats to
View area.
* Click Sample Enabled Objects
to calculate the volume of each
hippocampus.
Log Stats ] Auto Log Stats

B TN = Original
(W Mright_ Hippocamp | [ Display
[ et Hippocampu | Color White =

Inferior Inferior

Copyright 2010-2015, BIR, Maye Clinic
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Note: If subregions of the hippocampi
were identified during the segmentation
process, these objects can all be selected
and their volumes separately measured.
After the individual subregion volumes
are measured and logged, all subregions
for either the left or right hippocampus
can be enabled and the Combine
Enabled Objects checkbox checked.

This measurement will generate the total
hippocampal volume from the subregion
volumes. Once this has been done for
one side, the same can be done for the
other side. A further option would be to
add the subregion volumes in a separate
analysis software such as Microsoft Excel.
If this approach is used, a high enough
number of decimal places should be

chosen for the measurement to minimize

rounding error in the sums.

'3 MRI_3D_Head_ACPC - |

File Other Help

Name = Right_Hippocampus
Volume = 2639.00 mm3
Mean = 79.84

Name = Left_Hippocampus
Volume = 2521.00 mm3

Sample Type
10 | 2p N
Box Selected |Enabled Entire T
Object  |Objects| Volume o
Sample Options
Combine Enabled Objects  Name|Combined
Sample Enabled Objects |
Stats to View
General| Size sample[3-D  [Fractal|Boundary |Region
Intensity |Range | Shape Coords _ | Pixels
Orient Number of Voxels Histogram
V| Name Area
Slice ] Volume
Maximum ] Mean
Max Lacation St. Dev.
Minimum Sum
[£] Min Location Entropy
‘ Log Stats 7] Auto Log Stats | 30 |
V] Stats

Left Hippocampu | Color White

Mean = 80.51 b
T CPEI \orme Origine!
(M right Hippocamp Display

0
Indec  ObjectName  YOlUME pjean
mm3

1| Right_Hippocampus | 2639.00 | 7984
2| Left Hippocampus | 252100 | 8051

[ soeico ]

Clear Log
Dismiss Log

Remove Last Entry

Comment

Copyright 2010-2015, BIR, Mays Clinic

* The volume of each hippocampus will be shown in the Stats box in the bottom left of the window, and recorded in the log below the

images.

® The log can be saved by right-clicking.

* Click Save Log to output the measurements as a .stats file, which can then be opened in a spreadsheet and used for further analysis.

©2015 AnalyzeDirect, Inc.
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